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INSTRUCTIONS TO MARKERS 
 

To facilitate marking and moderation, the following must be adhered to when mark-

ing: 

 

Manipulation: 

• Use a blue pen for all manipulation commands carried out; 

• Use a tick/s and the question number for every correct manipulation carried out, 

as indicated in the marking guideline; 

• Use a X (cross) to mark manipulation incorrectly done.  

• The question number must be written next to every tick or X (e.g. 1.3 ��) 

 

Accuracy: 

• Use a red tick to indicate all accuracy marks 

• Use a red X to indicate all accuracy errors 

• For each command, the question number must be written next to every tick or 

X (e.g. 1.4 ������XX) 

 

ADDITIONAL INSTRUCTIONS FOR MARKING QUESTION 1 ONLY: 

1. If a printout of the Data Source is not supplied the following should be applied: 

• Mark the accuracy of the records (for 1.3 – 8 marks new record inserted), 

in the 3 printouts of the Merged letters i.e. Question 1C. 

• For 1.2 – 2 marks are lost for the question number omitted in the header. 

  2 marks are lost for not opening the file (named Guide) 

• For 1.4 – 1 mark is lost – Question 1A (data source) not printed 

 

2. If no printout of the Primary Document (Question 1B) is included the following 

marks are lost: 

• 1.5 – 2 marks if the primary document is not opened (no evidence). 

• 1.6 – 1 mark for the header not inserted/incorrect. 

• 1.7 – 1.8 must be marked in the first merged letter. 
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If no printout of the Secondary document is included: 

• 1.9 – 2 marks lost – no evidence of documents being linked 

• 1.10 – 6 marks lost –  no evidence of merge fields being inserted; and       

2 marks lost for the missing merge fields – bold, italics 

• 1.11 – 2 marks lost – no printout of the Primary Document. 

• 1.12 – 1 mark lost – question number not changed to Question 1C 

3. If no printout of the merged invitations is included, marks for 1.13 and 1.14 are 

lost. 

 

4. If the records in the merged field, (in Question 1C) differ from the Data Source 
Question 1A, then regard Question 1C as invalid and do not allocate any marks 
to Question 1C. 

 
 
Keep in mind that most Colleges have some sort of restrictions. This is different at 
each campus. Ensure that you are aware of these restrictions and do not penalise 
the students if they were unable to access a particular feature. 
 
There are just too many different options to consider at the colleges e.g. 
 
Windows XP and Office 2003 
Windows XP and Office 2007 
Windows XP and Office 2010 
 
Windows Vista and Office 2007 
Windows Vista and Office 2010 
 
Windows 7 and Office 2003 
Windows 7 and Office 2007 
Windows 7 and Office 2010 
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****When the examiner created the headers, the different first page option was used, 
which means:  -in the Questions that have been sent to students, their exam num-
bers only appear on the first page. It is not the student’s job to correct this, therefore 
they can’t be penalised if their exam number doesn’t appear on pages 2, 3, and 4.  
As long as it appears on page 1 
 

QUESTION 1  [50] 
 

1.1 Retrieved the file called GUIDE  (2) 
 

1.2 Examination number 
QUESTION 1A 
As a footer 

  
(1) 
(1) 

 
1.3 Inserted new record 

Accuracy 
 (2) 

(6) 
 

1.4  Printed data source  (1) 
 

1.5 Opened MEMO  (2) 
 

1.6 Inserted footer: right aligned 
Examination number 

QUESTION 1B 

  
 

(2) 
 

1.7 Inserted heading Two lines spaces after letterhead; Accuracy:  MEMO 
Spaced caps 
Bold 
Centre 

 (3) 
(1) 
(1) 
(1) 

 
1.8  Inserted text - footer 

Left align 
Font size 10 
Bold 
Accuracy  

 (1) 
(1) 
(1) 
(1) 
(2) 

 
1.9 Linked primary (MEMO) and secondary document  (2) 

 
1.10 Replaced text with merge fields 

Fields appear in bold and italics 
 (6) 

(2) 
 

1.11 Printed the primary/main document  (2) 
1.12 Changed the question number to QUESTION 1C  (1) 

 
1.13 Merged document: 

• Letter 1 

• Letter 2 

• Letter 3 

  
(2) 
(2) 
(2) 

 
1.14 Printed the final document  (2) 
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TOUR GUIDE TOUR DEPARTURE 
DATE 

BOOKED MAXIMUM AVAILABLE 

Alex Mac-
donald 

Kismet-Pewter Art 
Studio 

20 April 2011 15 30 5 

Chris Mata-
wana 

Emily Hobhouse 
Memorial 

21 April 2011 20 30 10 

Stan Wiseman Old Jail (1872) 21 April 2011 15 20 5 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Examination number 
QUESTION 1A 
 
 

1.2  ���� examination number    ���� as a footer 
 

1.3  �������� inserted record  ������������������������ accuracy 

1.4 

���� print data source 

1.1 �������� Opened/Retrieved file 
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STARS ACCOMODATION AND TOURS 

 
                                                                                                                                                                             

PO Box 196                                                                                                                                   Tel:  011 543 6986 

Ellis Park                                                                                       Fax:  011 543 6985 

JOHANNESBURG                                                                              Cell:  072 456 8789 

2094                                                                                            E-mail: saat@gmail.com 

 

 
M E M O 

 
To:  «TOUR_GUIDE»                                                         Date:  25 January 2011 
From:  A. Levendal                                                             Time:  15:00 
Topic:  Tour Bookings 
 
Dear Sir/Madam 
 
The following summary of tour and reservation has not been confirmed yet.  This 
matter needs your urgent attention in order to fully reserve all tours. 
 
The deadline for confirmation is 25 February 2011. 
 
Tours: * 
Departure date: 
Number of reservations: 
Maximum tourists: 
Places available: 

«TOUR» 
«DEPARTUREDATE» 
«BOOKED»  
«MAXIMUM» 
«AVAILABLE» 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.9 

�������� linked documents 

1.7    ���� inserted word       ���� spaced caps             

���� two lines after letterhead  ���� bold ���� centre   ���� accuracy 

 

 

1.6 

����footer 

����right aligned 

1.8 

����inserted text – as a footer  

���� left aligned 

����font size 10 

����bold 

��������accuracy 

1.10 ���� replaced field 

1.10  

������������������������ replaced fields  

�������� all fields bold, italics 

1.11 �������� print 

1.5  �������� opened file 
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STARS ACCOMODATION AND TOURS 

 
                                                                                                                                                                             

PO Box 196                                                                                                                                   Tel:  011 543 6986 

Ellis Park                                                                                       Fax:  011 543 6985 

JOHANNESBURG                                                                              Cell:  072 456 8789 

2094                                                                                            E-mail: saat@gmail.com 

 

 
M E M O  

To:  Alex Macdonald                                                         Date:  25 January 2011 
From:  A. Levendal                                                             Time:  15:00 
Topic:  Tour Bookings 
 
Dear Sir/Madam 
 
The following summary of tour and reservation has not been confirmed yet.  This 
matter needs your urgent attention in order to fully reserve all tours. 
 
The deadline for confirmation is 25 February 2011. 
 
Tours: * 
Departure date: 
Number of reservations: 
Maximum tourists: 
Places available: 

Kismet-Pewter Art Studio 
20 April 2011 
15 
30 
5 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*see enclosed brochure for prices.                                                                                    Examination number 
 QUESTION 1B 

 

*see enclosed brochure for prices.                                                                                  Examination number 
QUESTION 1C 

 

1.12 ���� changed question number 

         all three merged letters 

         accept footer or header 

1.13 �������� merge 



MARKING GUIDELINE                                                                             
NC1950(E)(O20)V 

OFFICE DATA PROCESSING L3 

Copyright reserved  Please turn over 

- 8 - 

 
    

STARS ACCOMODATION AND TOURS 

 
                                                                                                                                                                             

PO Box 196                                                                                                                                   Tel:  011 543 6986 

Ellis Park                                                                                       Fax:  011 543 6985 

JOHANNESBURG                                                                              Cell:  072 456 8789 

2094                                                                                            E-mail: saat@gmail.com 

 

 
M E M O  

To:  Chris Matawana                                                         Date:  25 January 2011 
From:  A. Levendal                                                             Time:  15:00 
Topic:  Tour Bookings 
 
Dear Sir/Madam 
 
The following summary of tour and reservation has not been confirmed yet.  This 
matter needs your urgent attention in order to fully reserve all tours. 
 
The deadline for confirmation is 25 February 2011. 
 
Tours: * 
Departure date: 
Number of reservations: 
Maximum tourists: 
Places available: 

Emily Hobhouse Memorial 
21 April 2011 
20 
30 
10 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*see enclosed brochure for prices.                                                                                  Examination number 
QUESTION 1C 

 

1.13 �������� merge 
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STARS ACCOMODATION AND TOURS 

 
                                                                                                                                                                             

PO Box 196                                                                                                                                   Tel:  011 543 6986 

Ellis Park                                                                                       Fax:  011 543 6985 

JOHANNESBURG                                                                              Cell:  072 456 8789 

2094                                                                                            E-mail: saat@gmail.com 

 

 
M E M O  

To:  Stan Wiseman                                                         Date:  25 January 2011 
From:  A. Levendal                                                             Time:  15:00 
Topic:  Tour Bookings 
 
Dear Sir/Madam 
 
The following summary of tour and reservation has not been confirmed yet.  This 
matter needs your urgent attention in order to fully reserve all tours. 
 
The deadline for confirmation is 25 February 2011. 
 
Tours: * 
Departure date: 
Number of reservations: 
Maximum tourists: 
Places available: 

Old Jail (1872) 
21 April 2011 
15 
20 
5 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*see enclosed brochure for prices.                                                                                   Examination number 
QUESTION 1C 

 

1.13 �������� merge 

1.14 �������� print three merged                

          letters 
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QUESTION 2  [70] 
 

2.1 Opened the file PHILIPPOLIS.  (2) 
 

2.2 Inserted examination number footer  (1) 
 

2.3.1 Inserted heading: 
Top centre 
Tahoma 24 
Bold  
Accuracy 

  
(1) 
(2) 
(1) 
(2) 

 
2.3.2 Changed the left and right margins.  (2) 
 

2.3.3 Inserted text 
Two lines after heading 
Style heading 2 (Style 3 as per question paper) 
Centre 
Accuracy 

 (1) 
(1) 
(1) 
(1) 
(1) 

 
2.3.4 Deleted paragraph 4-6  (2) 
    
2.3.5 Inserted a page break  (2) 
    
2.3.6 Performed spell check – words corrected:  Missionary, conflict, centre.  (3) 
    
2.3.7 Inserted page number 

Bottom right  
Format  

 (1) 
(2) 
(1) 

    
2.3.8 Changed paragraph to a bulleted list 

Double line spacing 
Inserted bullets of own choice (commas omitted) 

 (1) 
(1) 
(1) 

    
2.3.9 Inserted a 4½ pt border around paragraphs 1-3  (2) 
    
2.3.10 Inserted table 

Correct columns and rows 
Merged cells 
Accuracy 

 (1) 
(1) 
(1) 
(7) 

 * Nothing is mentioned in memo about the table being 3 line spaces after the 
heading, so we accept any distance from the heading. 
 
 

  

2.3.11 Applied Table AutoFormat  (2) 
    
2.3.12 Save and Print document  (2) 
    

(46) 



MARKING GUIDELINE  NC1950(E)(O20)V 
OFFICE DATA PROCESSING L3 

Copyright reserved              Please turn over 

- 11 - 

 



MARKING GUIDELINE                                                                            NC1950(E)(O20)V 
OFFICE DATA PROCESSING L3 

Copyright reserved  Please turn over 

- 12 - 

2.3.6  ������������ Spell check  

 
 

 
PHILIPPOLIS 

 

BACKGROUND  
 

 

Philippolis has a rich history – not only as the oldest settlement in what is now the Free State, 
having been established as a station of the London Missionary Society (LMS) in 1822/1823, but 
also as a centre of the Griqua captaincies from the 1820s to the 1860s and, later, as a conflict 
zone in the Anglo-Boer war.  
 
Close to the geographic centre of South Africa, Philippolis is well placed as an off-the-highway 
stop-over for tourists travelling between the Western, Southern and Eastern Cape in the south, 
and Botswana, Johannesburg-Pretoria in the north, and KwaZulu-Natal and Mpumalanga in the 
east. The deviation off the N1 highway on the R717 between Colesberg and Trompsburg is in 
fact shorter than the actual N1, making this not a detour at all.  
 
Philippolis is a major centre for sheep-farming, horse-breeding, game hunting and eco-tourism.  

2.3.2  ���� left margin (1.5”/3.8 cm) 2.3.2  ���� right margin (1.5”/3.8 cm) 

2.3.1 ���� Accuracy 
       ���� Insert heading 

       ���� top centre 

       ���� font (Tahoma) 

       ���� size 24 

       ���� bold    

        accuracy 

EXAMINATION NUMBER                                                                                 -1- 
QUESTION 2        2.2 ���� inserted examination number                            

2.3.3 ���� inserted text   ���� two lines after heading  ���� Style heading 2/3  ����Accuracy  ���� centre 

2.3.4  ������������  deleted paragraph 4 to 6 

2.3.5  ��������  inserted page break 

2.3.7  ����  inserted page numbers 

      ��������  bottom right 

        ����  format 

       

2.3.9  ��������  inserted 4½ paragraph border 

2.1  ��������opened file 
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EXAMINATION NUMBER                                                                                 -2- 
QUESTION 2         

 
 

SOME BUILDINGS AND ARTIFACTS OF INTEREST TO TOURISTS 
 

� Adam Kok’s House (1843) 

� Cannons 

� Cemetery 

� Emily Hobhouse Memorial  

� Old jail 

� Kruithuis (Powder House) 

� Museum 

OTHER TOWNS AND ATTRACTION AREAS 
 

HISTORICAL SITES 

Springfontein 
 
 
Jagersfontein 
 
 
 
Fauresmith 
 
Gariep en Van der Kloof 

One of the largest concentration camps of the Anglo-Boer 
War. 
 
The Big Hole at the (now closed) Jagersfontein diamond mine 
in the world’s largest hand-dug excavation (larger than the 
better-known Kimberley Big Hole). 
 
Steam locomotive preserved in the centre of its main street. 
 
Two of the country’s largest storage and irrigation dams, are 
both holiday resorts. 

 

 
 
 
 
 

2.3.8  ����  changed to bulleted list 

        ����  double line spacing 

� inserted bullets of own choice 

(commas omitted) 

2.3.10  ���� inserted table        ���� correct columns and rows     ����  merge cell (row 1)     ����������������������������  accuracy 

 

 

2.3.11 �������� applied AutoFormat 

2.3.12    ��������   print  
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2.4 Opened/Retrieved the file ACCOMMODATION  (2) 
 
2.4.1 

 
Inserted examination number 

 
(1) 

 
2.4.2 Inserted Heading 

Top centre 
Word Art 
Accuracy 

 (1) 
(2) 
(1) 
(2) 

    
2.4.3 Inserted AutoShape two lines before the text on the centre of the page  (2) 
    
2.4.4 Inserted text in shape, bold and centered 

Accuracy 
 (3) 

(2) 
 

2.4.5 Applied the 3D style 3 to shape  (2) 
    
2.4.6 Page vertically and horizontally centered  (2) 
    
2.4.7 Inserted picture, top right 

Changed size of picture 
 (2) 

(1) 
    
2.3.8 Printed the document.  (1) 
    

(24) 
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Star Nights has just been renovated - original oregon floors and doors! 
 

There are 4 self-catering cottages: 
 

Cottage 1: 1 bedroom, 1 bathroom, kitchen, lounge/dining room, private courtyard 
Cottage 2: 2 bedrooms, 1 bathroom, kitchen, lounge/dining room 

Cottage 3: 3 bedrooms, 2 bathrooms, lounge, dining, kitchen. 
Cottage 4 (national monument): 1 bedroom, 1 bathroom, kitchen, lounge/dining room, private 

courtyard 
It is an example of the earliest urban architecture. The rectangular flat-roofed house was a typi-

cal style from the 1850 – 1890 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Visit our web site for more information 
www.starnights.co.za 

 
Contact us:  Tel: 051 733 0063 / Fax: 086 634 5412   

Cell: 082 654 8645 
E-mail: info@starnights.co.za 

 
Banking details:  K Basson (savings) 

ABSA 58 08 41 31 025 
Branch Code: 632005 

Confirmation: 
Fax: 086 634 5412 

 

 

2.4.8 

 ���� printed document 

 
 

2.4. �������� opened file 

 

2.4.2 ���� inserted heading 

���� Word Art ��������top centre 

��������accuracy 

 
COME AND 
ENJOY THE 

STAY!!! 

2.4.3 ���� inserted shape 

       ���� centre across 

2.4.4 

���� inserted text in shape 

�������� bold and centred 

��������accuracy 

 

2.4.5 �������� applied 3D style 3 

2.4.6  

�������� vertically and horizontally 

     centred 

2.4.7 

���� inserted picture  

���� top right  

���� resized 

2.4.1 

 ���� inserted examination number 

 
 EXAMINATION NUMBER: 
QUESTION 2.4 
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QUESTION 3  [60] 
 

3.1 Opened QUESTION 3. 
Inserted Examination number  

 (2) 
(1) 

    
3.2 Opened MS Outlook  (2) 
 

3.2.1 Created contacts in Address Book 

• Created 

• Sajana Mentor – sajana@gmail.co.za 

  
(2) 
(2) 

    
3.2.2 Made a print screen image of the contacts folder. 

 
 (2) 

 
  3.2 �������� Open Outlook 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.2.3 Applied stationery or background texture of own choice to the message  (2) 
 (Not all email programs being used have stationary or backgrounds)   
3.2.4 Composed message  (10) 
    
3.2.5 Added image file as an attachment  (2) 
    
3.2.6 Made the importance of message - high priority  (2) 
    
3.2.7 Made a print screen image of the message and pasted in answer file.  (2) 
 
 
 
 
 
  
 
 

3.2.1  

��������  created 

��������  contact 1 

3.2.2  �������� print screen 
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3.2.6 ��������  high priority 

 

 
 
 

3.2.8 
 
 
3.2.9 

Opened Help function in MS Outlook 
Searched for information (instruction unclear) 
 
Pasted information 

 (1) 
(2) 

 
(2) 

 

In the e-mail message you want to copy the names from, select the names in the To or Cc box.  

On the Edit menu, click Copy.  

On the File menu, point to New, and then click Distribution List.  

In the Name box, type a name for the distribution list.  

Click Select Members.  

In the Add to distribution list, right-click, and then click Paste on the shortcut menu. 
 

 
  (34) 

3.2.4  ��������    

3.2.4  �������� 

3.2.5  �������� Attachment 

3.2.3  �������� Stationery or textured 

background 

3.2.4  ������������������������ Accuracy 

3.2.7  �������� Print screen 

3.2.8  ���� Help �������� correct info - 

(instruction unclear – accept any 

text copied) 
3.2.9  �������� copied info .0 
 

3.2.6  �������� High priority 

Layout of the brochure 

Attach file must be Hotel 

not Accommodation 
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3.3 Opened Help and Support 

Select Index icon/tab (Win 7 doesn’t have Index tab in Help & Support.  Stu-
dents can’t be penalised) 
 
Select correct information 

   (2) 
 
  (2) 
 
  (2) 

 
3.4 Print screen  (2) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3.5 Open Internet Explorer 

Click TOOLS;  
Select INTERNET OPTIONS 
Select the General Tab 
Type the address of the Home page in the Home Page space 
Click Apply, OK 

 (1) 
(1) 
(1) 
(1) 
(1) 
(1) 

 
3.6 Print screen image of home page  (2) 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.3 ��������  Help 

3.4 �������� Print screen 

3.6 �������� print screen 

3.3 ��������  Index tab 

3.3��������  correct info 
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3.7.1 B (2) 
3.7.2 D (2) 
3.7.3 A (2) 
3.7.4 G (2) 
3.7.5 E (2) 

 (5 x 2) (10) 
(26) 

 

 

QUESTION 4  [60] 
 
Opened file. 
Inserted examination number 

 (1) 
(1) 

4.1.1 Letters are not so easy to read on a smaller screen 
A larger screen demands too much eye movement 

�� 
�� 

(4) 

    
4.1.2 A – Arm’s length plus 8cm away     

B – 18 to 20 cm away                                       
�� 
�� 

(4) 

    
4.2 It may cause repetitive neck strain and;  

It may lead to improper neck posture. 
�� 
�� 

(4) 

    
4.3 Correspondence 

To be able to create certain documents such as menus, tables, min-
utes and agendas. 
To create mail merge documents 
To be able to create job documents 
To type certain types of letters etc.                 (Any applicable answer)  

� 
� 
� 
 (3) 

    
4.4.1 Avoid downloading software from bulletin board systems, computer 

games from friends. 
Avoid sharing diskettes on computers and networks. 
Install an anti-virus program. 
Do not use pirated software. 
Not to open unknown e-mails. 
Update your anti-virus regularly 
Avoid web pages that offer free mp3 downloads          (Any applicable 
5 answers) 

�� 
 

�� 
�� 
�� 
�� 

 

 
 
 
 
 

(10) 

    
4.5.1 G �� 
4.5.2 H �� 
4.5.3 C �� 
4.5.4 A �� 
4.5.5 B (Students may choose “C” here) �� 
4.5.6 D �� 
4.5.7 E �� 

(14) 
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4.6.1 C  (2) 
4.6.2 A  (2) 
4.6.3 B  (2) 
4.6.4 A  (2) 
4.6.5 B  (2) 
 
 

4.7.1 Copyright  (1) 
    
4.7.2 It is the right of the creator to control the use of his/her information.  (2) 
    
4.7.3 Because the creator is protected by copyright from another person  

using his/her work as though it were their own. 
 

(2) 
 

4.8  Abbreviation Type of memory   

 Random Access Memory: RAM Temporary Memory �� (4x1) 
 Read Only Memory: ROM Permanent Memory �� (4) 
There is no space on the answer file for Abbreviation and/or Type of Memory.  Its also not 
asked on the question paper to provide the abbreviations.  Thus:  students can’t be penalised if 
they don’t give the abbreviations or state what type of memory it is.  In fact, we’ll have to accept 
any broad explanation of what it is. 
 
 
 

QUESTION 5  [60] 
 

5.1 Opened/Retrieved the answer file saved as QUESTION 5, examination no 

header left 

 
(2) 

    
5.1.1 File Name File Size   

(a)  Accommodation 20 KB  
 Jazz festival 152 KB 

�� 
�� 

 

      
 (b) Internal exam report 26 KB ��  
  Office Data Processing L3 14 KB ��  

      
 (c) Ad face 899 x 629 (This is not the file size, 

but the size of the picture) 
�� 

 

      
 (d) Phillipolis 8 KB ��  
     (12) 
5.1.2 (a) Phillipolis.ppt ��  

 (b) Jazz festival.doc ��  
 (c) Accommodation.doc ��  
  (3 x 2)  (6) 
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5.1.3 Opened Windows Explorer and created the folder called FESTIVALS  (3) 
    
5.1.3.1 Copied the file CALENDAR into FESTIVALS FOLDER  (1) 
5.1.4  Changed the view to THUMBNAILS.  (2) 
 Win 7 doesn’t have thumbnails.  Also accept Medium Icons   
5.1.5 Made a print screen image.  (1) 
 

 
 
Folder 

according to question paper is FESTIVAL and not FESTIVALS 
 

5.1.6 Opened Help and Support from the Start Menu and searched for information 
on how to add shortcut icons to the desktop. 

 
(4) 

 
5.1.7 Used the print screen function to make a copy of the desktop and pasted in 

the space provided. 
 

(1) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.1.3���� Opened Windows

5.1.3.1 ���� Copied file 

5.1.3
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5.1.8 Changed the file attribute of FESTIVALS to read only (see mark allocation be-
low). 

 
(4) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.1.9 Used the print screen function to make a copy of the desktop and pasted in 
the space provided. 

 
(1) 

 
5.1.10 On the desktop:  moved the recycle bin icon bottom right and arranged the 

icons to the top of screen in a horizontal row. 
 

(3) 

 
5.1.11 Changed the desktop to the Bliss theme.  (2) 
 Our students have restricted access to computer backgrounds and we don’t 

have a Bliss theme. 
We’ve instructed students to make a screen shot to show where they will change 
it 
Give students the benefit if they didn’t have access to bliss’ 

 

 

5.1.7 ���� Print screen 

5.1.6 ���� search 

Criteria inserted 

5.1.6 ���� Opened Help and Support 

5.1.6 �������� correct information 

5.1.8 �������� folder selected 

5.1.8�������� 
Read only selected  

5.1.9 ���� Print screen 
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5.1.12 Made a print screen image.  (1) 

 

 
 

5.1.13 Opened MS Word Help �������� function and searched for information about how to 
change page margins. �������� 

 
(4) 

    
5.1.14  Copied one paragraph of the information.  (2) 
    
 1. On the File menu, click Page Setup, and then click the Margins tab.  

2. Under Margins, select the options you want.       5.1.14 �������� correct information copied & pasted 

 
 

 
5.1.15  Start � 

Control Panel� 
Click on Mouse properties� 
Select the Buttons tab and select right handed option� 
Click Apply, OK� 

  
 
 
 

(5) 
 

5.1.16 Double click on recycle bin on desktop� 
Select the items to be restored� 
Right click on the selection, � click Restore; � OR 
 
Double click on the recycle bin on the desktop� 
Select the items to be restored� 
Click File from the Menu; � click Restore� 

  
 
 
 
 
 

(4) 
    
5.1.17 Printed Question 3 to Question 5  (2) 
   [60] 

 
 TOTAL  300 

 

5.1.11�������� Changed desktop 
to Bliss 

5.1.10   ���� Moved recycle   
                  bin 

5.1.10�������� Moved icons in 
horizontal   

     row 

5.1.12���� Print screen 


